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Before You Begin
These manual describes how to operate and configure the optiClient Attendant V6.0 PC 
attendant console on your HiPath communications platform.

This manual is supplied with the optiClient Attendant as online help and can be called up 
at any time Æ Page 15.

While the instructions describe all optiClient Attendant functions, you may find that some 
functions you wish to use are not available. This is due to one of the following reasons:
• The function has not been configured for your optiClient Attendant system. Address 

any questions to your system administrator.
• Your communications platform does not support this function. Address any questions 

to the Siemens sales representative responsible for upgrading your system.
• You do not have the latest version of the optiClient Attendant software. Contact your 

Siemens sales representative to update the software.

The information provided in this document contains merely general descriptions or charac-
teristics of performance which in case of actual use do not always apply as described or 
which may change as a result of further development of the products. 
An obligation to provide the respective characteristics shall only exist if expressly agreed 
in the terms of contract.

optiClient Attendant
In purchasing the optiClient Attendant, you have acquired an advanced PC attendant con-
sole for your HiPath communications platform.
Your PC must be connected to your communications platform to perform all switching 
functions from your PC.
Three different options are available for this, depending on the implementation site:
• Via the optiClient 130 software installed on your PC.
• Via a USB cable to an optiPoint 500 or optiPoint 600 office system telephone at your 

communications platform.
• Via the control/data adapter on the optiset E system telephone at your communica-

tions platform.

The optiClient Attendant software is compatible with different Windows operating sys-
tems so that you can conveniently transfer telephone calls and look up phone numbers in 
Outlook “Contacts” while simultaneously running other PC applications such as 
Microsoft® Office programs.

The optiClient Attendant attendant console provides you with:
• A variety of switching and administration functions;
• A high degree of user friendliness thanks to the:

– Clearly designed Windows-based user interface;
– Straightforward operation using a keyboard and mouse;

• Simultaneous use of other PC applications;
• Supports two screen solutions (ask your relevant service personnel),
• Direct switching from Microsoft Outlook “Contacts”, and
• A user-friendly search option in Microsoft Outlook “Contacts”, busy lamp field and sys-

tem telephone directory.
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Basic Operating Instructions
Basic Operating Instructions

User Interface of optiClient Attendant

optiClient Attendant main window

Busy lamp field(s) (display optional)

Menu Window (may be activated)
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Basic Operating Instructions
How To Use These Operating Instructions
You will find a graphic representation of the steps in logical se-
quence on the left side. Below is an explanation of the symbols:

Click the right mouse button once.

Hold down the left mouse button and move the mouse (click and drag).

Click the left mouse button twice.

Click the left mouse button once.

Enter letters or numbers from the PC keyboard 
(for example, user names or station numbers).

Select an option from the menu bar, a pop-up menu or a tab in a program 
window.

Press Return to accept input from the keyboard or confirm a program call.

Click the button with the left mouse button.

Press the key on the PC keyboard.

1. A numbered list describes steps you must complete in the order given.
• Bulleted text indicates an enumeration.

Æ Page 9Reference to a page.

Space Bar

F3

Note or remark.
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Basic Operating Instructions
Overview of Features
• Incoming and outgoing call display
• Call answering/dialing/transferring
• Toggling between two calls
• Three-party conference
• Call holding and parking
• Redialing of the last ten numbers dialed
• Dialing with busy lamp field and repertory dial keys
• Dial via Caller list
• Callback and send message
• Call override
• Activate/deactivate call forwarding
• Activate/deactivate night answer
• Telephone book functions 

(in the ETB using Microsoft Outlook “Contacts”):
– Look up and display stations
– Look up and display station data
– Automatic provision of the station number for dialing

Main Improvements and Changes
• Enhanced caller list Æ Page 75
• Statistics function for incoming calls with extensive sorting options 

Æ Page 105
• Dial in canonical form with Outlook “Contacts” Æ Page 83 and LDAP 

searches Æ Page 88
• Internal telephone book (ETD) Æ Page 77 can be imported from 

Attendant P V4.0 (ask relevant service personnel for further details)
• Simplified Configuration Manager start-up Æ Page 99
• Zoom option in the busy lamp fields Æ Page 23
• Easy to operate enter, delete and speed transfer functions via a popup 

menu in the busy lamp field Æ Page 25, Æ Page 26, Æ Page 42
• Improved program interface (for example, toolbar regrouping, integrat-

ing the display in the main window)

Convenient Call Number Search
The optiClient Attendant enables you to access different data sources for 
the station number search, depending on your configuration.
• Searching in the Electronic Telephone book (ETB) Æ Page 77
• Searching in the Microsoft Outlook contacts (if Microsoft Outlook is in-

stalled) Æ Page 83
• Searching in the telephone book Æ Page 86
• Searching in the telephone book on CD-ROM (if the CD-ROM is avail-

able) Æ Page 87
• Searching per LDAP server (if LDAP server is available) Æ Page 88

If a desired function is not available, please contact the relevant service 
personnel.
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Basic Operating Instructions
Target Group for this Manual
This manual is intended both for personnel working with the Hicom 
optiClient Attendant attendant console who are familiar with the Windows 
user interface and for System Support (service personnel), who configure 
and oversee the optiClient Attendant attendant console.

The manual contains all the information you will need to operate and con-
figure the optiClient Attendant attendant console:
• To make important information easy to find, the first section of this 

manual deals with Operating the optiClient AttendantÆ Page 13.
• The second section describes Configuring the optiClient Attendant 

and operating the Configuration Manager Æ Page 91.
• If you run into any problems operating the optiClient Attendant, refer to 

the third section of this manual, Error Correction in optiClient 
Attendant.Æ Page 107

• The chapter Important Keyboard Commands provides an overview 
of shortcuts and function keys Æ Page 113.

Requirements
You or System Support must install the attendant console hardware and 
optiClient Attendant software for the Microsoft Windows operating sys-
tem on your PC (see Installation Instructions in the optiClient Attendant 
CD-ROM booklet).

The PC’s power management system must not be activated during 
optiClient Attendant

To use the telephone book functions (ETB) with Microsoft Outlook, Mi-
crosoft Outlook must be installed on the PC.

An LDAP server must be available to use the LDAP search function.

Operating optiClient Attendant requires some elementary knowledge of 
PCs and Windows.

For hardware and software requirements, please refer to the Installation 
Instructions in the optiClient Attendant CD-ROM booklet.

Operating the optiClient Attendant

Whenever the optiClient Attendant is used with various user pro-
files, it may be necessary to change the access rights for the con-
figuration files before configuring the optiClient Attendant itself. If 
this is the case, please contact your system specialist or administra-
tor.
12



Operating optiClient Attendant
Operating optiClient Attendant
You can configure your attendant console PC so that the 
optiClient Attendant switching program starts up automatically when you 
switch on the PC. 
If the program has not been configured to start up automatically, you must 
start it manually or set up optiClient Attendant for automatic start up.

Automatic startup

Switch on the attendant console PC. As soon as your operating system 
loads, optiClient Attendant automatically starts up and the program win-
dow opens.

Manual startup

When you install the program, it is added to the Programs section of the 
Start menu of your operating system.

Start up the optiClient Attendant from the Start menu. The program win-
dow with the attendant monitor opens.

Configuring Automatic Startup (Example: Windows 2000)

1. Click the “Start” button on the task bar and select “Settings”, 
“Taskbar & Start menu...”,  and then click the “Advanced” tab in the 
next window.

2. Click the “Advanced” button.
The “Explorer - Start menu” window will open.

3. In the left column, open the “Program files” directory and locate the 
optiClient Attendant directory.

4. Right-click to copy the “optiClient Attendant“shortcut to the right 
column.

5. Go to the “Autostart” folder in the left column and insert the 
“optiClient Attendant” shortcut into the right column, using the right 
mouse button.

6. Close “Exploring”. On the “Task Bar Properties” screen, click “Apply”, 
then “OK”. Exit and re-start the PC.
13



User Interface - Desktop
User Interface - Desktop
The optiClient Attendant program windows are your work area.
The program windows can be independently positioned on the screen.

Program windows include:
• the optiClient Attendant main window

with menu bar Æ Page 15, toolbarÆ Page 16, the attendant monitor 
Æ Page 18 and status bar Æ Page 17.

• the busy lamp fields Æ Page 23 (max. 3, display optional) and
• the menu Window Æ Page 27 (may be activated).

For certain functions, you can open additional windows, for example:
ETD Æ Page 77, Search the telephone book Æ Page 86, Directory CD 
search window Æ Page 87, LDAP server search window Æ Page 88, Win-
dows Notebook Æ Page 72.

Busy lamp field(s)
(Display optional)

Menu window
(may be activated)

Status bar

Menu bar Toolbar

Attendant Monitor
14



User Interface - Desktop
Main Window

Menu bar
The menu bar contains a series of main menu options. Clicking one of 
these main menu options with the left mouse button opens a correspond-
ing submenu (pull-down menu) with additional menu options.
• File

This menu allows you to configure general settings for the 
optiClient Attendant. The Exit command terminates the 
optiClient Attendant application.

• Edit
Use this option to activate DTMF suffix-dialing during a call, select the 
night answer destination and activate/deactivate various functions.

• Window
With this menu, you can call the busy lamp field, the Windows note-
book and the search window.

• Repdial keys (optional)
You can dial your party directly from this menu with these repdial keys.
(This menu option only if you have configured repdial keys in the 
optiClient Attendant).

• Find
From this menu, you can selectively search for the names, companies, 
cities or postal codes of any stations in the Microsoft Outlook “Con-
tacts” folder.

• Paging (optional)
This menu option allows you to broadcast a speaker announcement to 
telephones in a specific group.
(This menu option appears only if you have configured paging groups 
and have activated them in the optiClient Attendant.)

• Language
Use this option to set the language that you want optiClient Attendant 
to use for menus and dialog boxes (windows)

• ? (Help)
Use the “Help” option to access the optiClient Attendant context-sen-
sitive online help function, where you will find general information on 
the program layout and explanations of the individual functions.
Use the “About...” option to view general information about 
optiClient Attendant.
15



User Interface - Desktop
Toolbar
In the talk state or idle state you can call important functions from the tool-
bar by clicking them with the mouse.
In the case of functions which can be activated or deactivated, an icon in 
the status bar Æ Page 17 displays the activated function.
Some functions are only available in the toolbar if they are configured for 
your telephone.

Call busy lamp field Æ Page 23.

Display caller list Æ Page 75.

Open Configuration Manager Æ Page 99.

Display list of most recently dialed numbers Æ Page 42.

Activate/deactivate callback Æ Page 57.

Override busy station Æ Page 55.

Initiate conference Æ Page 53.

Set volume Æ Page 35.

Release trunk Æ Page 66.

Transfer trunk Æ Page 65.

Activate/deactivate night answer Æ Page 71.

Activate/deactivate call forwarding Æ Page 68.

Send message Æ Page 61.

Activate/deactivate calling line identification restriction Æ Page 56.

Initiate DTMF suffix dialing (tone dialing) Æ Page 40.

Open door lock Æ Page 36.

Request call charges (pay phone) Æ Page 73.

Speaker call Æ Page 60.

Open menu window Æ Page 27.

Call up Electronic Telephone Book (ETD) Æ Page 77.

Display popup menu for advanced search in Outlook Æ Page 85.

Start telephone directory CD Æ Page 87.

Opening search window for LDAP serverÆ Page 88.

Open search window for telephone book Æ Page 86.
16



User Interface - Desktop
Status Bar
Advisory and system messages on the status bar:
• The current status of optiClient Attendant during the loading operation 

is displayed on the right-hand side. The program is ready when System 
ready is displayed in the status bar.
If the data of the communications platform has been modified, the 
Please wait message appears in the system bar to inform you that the 
program is being updated with the new system data.

• In operational status, icons for the current settings are displayed on the 
left-hand side e.g. “Camp-on without tone” . 
To deactivate a function, left-click the relevant icon.
17



User Interface - Desktop
Attendant Monitor
The attendant monitor is the main work area of the attendant console. 
From here, you can control the switching functions and obtain information 
from your communications platform.
• You can answer all pending calls from the call display. 
• Any held or parked calls are indicated in the call list.
• The switching area allows you to initiate the switching functions.
• The traffic display indicates the current trunk seizure.

A pending call appears in the call display. When you call a party or answer 
a pending call, the data appears in the left column of the traffic display. If 
you call another station for switching purposes, the data for this station ap-
pears in the right column of the traffic display; the data of the held station 
appears in the call display.

Call list

Call Display Switching area

Traffic Display
18



User Interface - Desktop
Call Display

Waiting calls are displayed in the list boxes on the call display. Using the 
mouse, you can scroll through the list boxes and select individual calls. A 
call can be answered by clicking the answer call button .

You can also recognize the different call types by means of the flags and 
the list field where the call is displayed:

A priority call is always displayed at the top of the middle list field so that 
it is clearly visible.

The number of waiting calls is indicated to the right of the list boxes.

Type1

1 Type number for flagging in the statistics Æ Page 105.

Flag Field Call type
0 E: External External call

1 I: Internal Internal call 

2 P: Private Private call 
3 I: Internal Doorbell call

4 R: Internal Callback

5 W: External External recall
6 W: Internal Internal recall

7 A: External External call intercept 

8 A: Internal Internal call intercept 
9 W: Internal Internal recall from park

10 W: External External recall from park

11 P: Internal Priority call

E: 0891234567

I: 38041 Peters

P: 38559Miller

List boxes:

Answer call

Open list box

External calls
Internal calls

Personal calls
Number of waiting calls
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User Interface - Desktop
Switching area

You can call a user by manually entering the station number in the “Name/
Station number” entry field of the switching area. If you enter a name, a 
search for this name will be initiated in Æ Page 100 either the ETD 
Æ Page 43 or Microsoft Outlook “Contacts”Æ Page 83, depending on the 
Configuration Manager settings.

Call Processing Buttons

 Æ Page 51

 Æ Page 37

 Æ Page 54

 Æ Page 52

 Æ Page 37

Dialing Buttons

 Æ Page 39

 Æ Page 38

Only visible in the case of automatic line seizure:

 Æ Page 40
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User Interface - Desktop
Traffic Display

The upper column of the traffic display shows the first party when you an-
swer or place a call (same display as in an optiPoint device).
The passive call is displayed in the lower column of the traffic display if, 
for example, you put a party in consultation state to call a second party.

For internal calls, the station number and (if possible) the station name are 
displayed. For external calls, the station number and possibly the name are 
displayed only in the case of a networking connection (ISDN, IP) with 
CorNet N.

Name and/or number of 
passive party

Name or number of active 
party








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User Interface - Desktop
Call list

The call list indicates all calls which are currently on hold or parked.
If a text has been entered by the station user in connection with holding or 
parking, this is also displayed.
For information about configuring text input in connection with holding or 
parking, see Æ Page 103.

You can retrieve the call from the hold Æ Page 51 or park Æ Page 54 status 
by double-clicking the left mouse button on the entry in the call list.

Description of the situation
Holding/parking position
Held/parked station

Trunk> Position 0 - Smith is waiting for Miller
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User Interface - Desktop
Busy Lamp Field
The Busy Lamp Field (BLF) is used for signaling the line status of individual 
stations (e.g. “external busy”) with colors and for convenient and rapid sta-
tion number dialing.

Representation

Up to three busy lamp fields may be configured, each with max. 240 status 
keys, i.e. 720 status keys in total.

Every status key which has been assigned to a station Æ Page 25 displays 
the station’s number in Number mode. When the mouse pointer pauses 
on the key, the associated name, if available, is displayed as a tool tip. 

In Name mode, station numbers (if available) are immediately displayed as 
key labels. The relevant station number is displayed as a tool tip. Up to 140 
status keys may be configured per BLF in this mode.

Depending on the status key color configuration, different colors are used 
to signal the trunk status of the station.

You can resize a busy lamp field by clicking and dragging its margin. The 
size of the status keys and their labeling is automatically adapted; the num-
ber of status keys remains unchanged.

For further details on configuring BLFs (number of BLFs, labels, number 
of status keys, color and mode) see Æ Page 101 and Æ Page 102.

To select a station, click the status key assigned to this station Æ Page 41.
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User Interface - Desktop
Calling Up the Busy Lamp Field
The busy lamp field opens automatically when you start 
optiClient Attendant (depending on configuration Æ Page 102). If it does 
not appear, follow the steps below to open it:

Click the busy lamp field button in the toolbar.

or

Select the BLF option from the Window menu.

The busy lamp field (max. 3 configurable) appears:

When you click one of the labeled status keys, the number for this station 
is automatically dialed Æ Page 41.

Double-clicking a status key has the same effect as single-clicking it.

Status key
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User Interface - Desktop
Entering a Station
To assign status keys to internal stations, you must label the buttons with 
the station numbers.
This is possible by:
• setting the numbers and names of internal stations on the system on 

which the optiClient Attendant is registered Æ Page 92,
• manual input.

Manual Input

Select the busy lamp field.

Right-click the desired status key.
A popup menu with several functions opens.

Select “New entry” from the popup menu.
The following dialog box opens.

Enter the station number and click OK to confirm your entry.

The following dialog box opens.

Specify the name of the station, if desired. Confirm with the “OK” button.

The station is now saved under this status key.

You can also store codes for controlling voice mail systems and an-
swering machines on status keys.
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User Interface - Desktop
Moving Station Numbers
In the BLF, you can move station numbers from one status key to another 
in order to group certain station numbers for example.

Select the busy lamp field.

Press the “Ctrl” and “Shift” keys while simultaneously left- or right-clicking 
the status button that you want to move.

While holding down the mouse button, drag the status button to the posi-
tion required. When you release the mouse button, the station will be in 
the new position.

Deleting a Station

Select the busy lamp field.

Right-click the desired status key.
A popup menu with several functions opens.

Select “Delete entry” from the popup menu.
The station number is deleted from the busy lamp field.

Ctrl +

Deleting a station from the busy lamp field does not delete it from 
your system; in other words, you can reconfigure it at any time 
Æ Page 25.
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User Interface - Desktop
Menu Window
The Menu Window emulates the telephone display and keys (2 lines for 
optiset E and optiPoint 500 telephones/8 lines with optiset E memory and 
optiPoint 600 office). Likewise, some of this information is constantly dis-
played in the upper area of the traffic display of the attendant monitor 
Æ Page 18.

Calling the Menu Window

The menu window dialog box automatically appears when you initiate a 
procedure such as sending messages.

You can also call the menu window manually to execute functions or pro-
cedures that cannot be initiated via toolbar buttons or pop-up menus (for a 
description of these functions and procedures and how to execute them, 
refer to the user manual for your communications platform).

Click the “Menu Window” toolbar button.
The menu window is displayed.

To avoid incorrect menu text display (some characters missing), 
data compression should not be activated in the communications 
platform (to deactivate, ask your relevant service personnel).
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User Interface - Desktop
Operation

The keys have the following meanings:

Confirm a function.

Scroll between functions.

Confirm changes
(corresponds to the “DIAL” key on the optiset E memory/optiPoint 600 of-
fice).

Scroll between lines.

Delete input one letter at a time from right to left.

Call up window to input alphanumeric characters.

Set telephone (e.g. ringer volume)

Close the menu window.
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Making and Answering Calls
Making and Answering Calls

Answering Calls
The call display provides you with a convenient means of answering incom-
ing calls. It contains pull-down list boxes that display all pending external, 
internal and personal calls. You can selectively choose and answer any call.

Call Types

For a complete overview of all possible call types, see Æ Page 19. 
Examples:

• External: A call from a party outside your communications platform 
who has dialed the system number and operator number (such as 0) or 
whose call was not answered by an internal party (and 
optiClient Attendant is programmed as the intercept position).

• Internal: A call from another party to your communications platform.
• Private: A call from a party outside your communications platform who 

has dialed the system number and internal operator number (such as 
100).

When you receive an incoming call, you hear a signal via the telephone 
speaker and/or the PC speaker (depending on the setting) and also see a 
display on the telephone screen (only if optiPoint or optiset E telephones 
are installed) and in the call display list box. If, on the basis of the number, 
an entry is found in the telephone directory file, the corresponding name 
is also displayed.

If you are working with another Windows application when a call is 
received, the system automatically changes to the 
optiClient Attendant.
Note that the system cannot change to the optiClient Attendant 
while a screen saver is activated. In this case, the call is signaled by 
the speaker only.

A: 0891234567

I: 38041 Peters

P: 38559Miller

List boxes:

Answer call

Open list box

External calls
Internal calls

Personal calls
Number of waiting calls
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Making and Answering Calls
Answering a Call

 Left-click one of the handset buttons.
This accepts the first call waiting in the respective list field.

or

Click one of the arrows for the list box with the left mouse button to open 
the list and select the call that you wish to answer.

Answer the selected call.

or

Press the space bar on the keyboard.
This answers the first call in the queue, depending on the priority. The calls 
are prioritized as follows:
Recall - External calls - Internal calls - Personal calls.

The answered call appears in the traffic display:

Space Bar

When you answer a call, it makes no difference whether the tele-
phone handset is on-hook or off-hook because the telephone’s 
hookswitch is activated only during emergency operation 
Æ Page 89 (not in conjunction with optiClient 130).
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Making and Answering Calls
Using Call Waiting (Second Call)

Answering a Second Call (Call Waiting)
While you are engaged in a call, you are also available to other callers. Dur-
ing the call, you are informed acoustically (by a call waiting tone if this tone 
has not been deactivated Æ Page 32) and visually (in the call display) that 
a second call is waiting. The call continues to be signaled in the call display 
until you have answered it.

1.

Terminate the current call with the “Clear” button.
The waiting call is indicated in the call display.

or

Click the Hold button to place the current call on hold Æ Page 51. The wait-
ing call is signaled in the call display.

or

Click the Park button to park the current call Æ Page 54. The waiting call is 
signaled in the call display.

2.

Accept the call.
You are speaking to the second caller.

or

Space Bar
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Making and Answering Calls
Activating/Deactivating the Call Waiting Tone
The call waiting tone lets you know that a second caller is trying to reach 
you while you are engaged in another call.

If the call waiting tone is deactivated, the “Camp-on without tone” mes-
sage appears in the upper area of the traffic display. The waiting call (sec-
ond call) continues to be signaled visually in the display.

Deactivating the Call Waiting Tone

Select the “Camp-on without tone on/off” menu item from the “Edit” 
main menu. 

The camp-on tone is deactivated and the  icon appears in the status bar.

Activating the Call Waiting Tone

Select the “Camp-on without tone on/off” menu item from the “Edit” 
main menu. 

or

 Left-click the icon in the status bar.

The camp-on tone is activated and the  icon goes out.

The communication platform can be configured in such a way, that 
when the optiClient Attendant is started up, the call waiting tone is 
automatically deactivated (ask relevant service personnel).
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Making and Answering Calls
Picking up Calls
You can pick up calls for other telephones on your own telephone using the 
busy lamp field (not for stations in networked systems).
When a station is being called, the background of the status key turns (to 
set up the colors see Æ Page 101).

You cannot pick up a call
• if the status key is displaying one of the busy states; in this case the 

destination party already picked up the call,
• if you are engaged in another call or
• If the call display is signaling a call

Prerequisite: The background or label of a status button in the busy lamp 
field changes color (e.g. yellow).

With the left mouse button, click the colored status button for the station 
being called.

The call is picked up and you can speak to the other party.
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Making and Answering Calls
Activating/Deactivating the Ringer Signal
By connecting via USB or a control/data adapter you can deactivate the 
speaker on the system telephone, and thus the ringer signal on the tele-
phone receiving an incoming call. When the ringer signal on the telephone 
is deactivated, the telephone signals the call only visually, although you can 
have it signaled audibly using wave files (to activate wave files Æ Page 94 
and Æ Page 103).
optiClient Attendant can be configured so that the ringer signal for incom-
ing calls is automatically deactivated when optiClient Attendant starts up 
Æ Page 91. The “Mute on/off” message then appears in the menu win-
dow and the icon appears in the status bar. .

Deactivating the Ringer Signal

Select the menu item “Ringing on/off” from the “Edit” main window. 
 

The ringer signal is deactivated at the telephone and the  icon appears 
in the status bar.

Deactivating the Ringer Signal

Select the menu item “Ringing on/off” from the “Edit” main window. 
 

or

 Left-click the icon in the status bar.

The ringer signal is activated on the telephone and the  icon disappears 
from the status bar.
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Making and Answering Calls
Setting the Volume
You can change the volume of the handset speaker; in other words, you 
can select the volume at which you would like to hear the other party.

Prerequisite: You are making a call.

Click the volume button in the toolbar.

The menu window is displayed:

You can use the  and  buttons to set the volume at which you would 
like to hear the other party at any of eight different levels.

Activating/Deactivating the Microphone (Mute)
You can temporarily deactivate the microphone on your telephone handset 
or headset. If the microphone is deactivated, you can continue listening to 
the other party, but they can no longer hear you.

Prerequisite: You are making a call.

Deactivating the Microphone

Select “Mute on/off” from the “Edit” main menu. 

or

Press the “F9” key (this must be programmed Æ Page 102).

The microphone is deactivated.

Activating the Microphone

Select “Mute on/off” from the “Edit” main menu. 

or

Press the “F9” key (this must be programmed Æ Page 102).

The microphone is activated.

F9

F9
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Making and Answering Calls
Actuating the Entrance Telephone Connection/Door 
Opener

If a service technician has configured one or more entrance telephones, 
you can speak to visitors at the entrance telephone and activate the door 
opener from your own telephone. The entrance telephones are assigned 
internal station numbers.

Speaking to Visitors via the Entrance Telephone

Prerequisite: Your telephone rings and the entrance telephone station 
number appears in your call display.

Take the call within 30 seconds. You speak to the visitor on the entrance 
telephone.

or

Opening the Door

You can operate the door opener while engaged in a call with the entrance 
telephone or when your phone is idle.

Click the door lock button in the toolbar. 

The following dialog box is displayed:

Enter the entrance telephone’s internal station number and click OK to con-
firm your entry.
Simply click OK if the entrance telephone number appears in the window 
while you are talking to the entrance telephone party.

The door is opened.

This function is not available network-wide Æ Page 90.

Space Bar
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Terminating a Call
Terminating a Call

One Party

or
Click the “Clear” button (= hanging up) or the “F3” button (must be con-
figured Æ Page 102) to terminate your current call.

Two Parties

or
Click the “Back” button or press “F5” (this must be configured 
Æ Page 102) to terminate your current call and change to the waiting call.

If you are speaking to two parties alternately (toggling) or simultaneously 
(conferencing), you can interconnect the two parties by clicking the Con-
nect button (the Clear button is replaced by the Connect button).
optiClient Attendant returns to idle mode and you can answer other calls 
again.

F3

F5
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Making Calls
Making Calls
Your optiClient Attendant attendant console allows you to initiate internal 
and external calls. When placing an external outgoing call, you also have 
the option of setting it up as a personal call. Such calls are specially marked 
during call charge evaluation so that they can be billed separately.

Making External Calls
Enter the external code and the external station’s number. The number is 
dialed as soon as you press Enter.

or

Enter the external code and the external station’s number. Then click the 
General button. 
The station number is dialed.

Outgoing external calls can automatically be identified by the length 
of the number to be dialed. If the number exceeds a certain length, 
the external code is prefixed automatically. To configure automatic 
external codes see Æ Page 103.
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Making Calls
Personal Calls

Using the Private button, you can conduct external personal calls. These 
calls are specially marked for call charge evaluation.

Enter the external code and the external station’s number. Then click the 
Private button. The station number is dialed.

If you must dial the external code before dialing the external station 
number, the system is programmed so that automatic line seizure 
is deactivated. In this case, the Internal button does not appear in 
the attendant monitor. 
If automatic line seizure is activated, you do not need to dial the ex-
ternal code. However, for internal calls you must then click the In-
ternal button before dialing.
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Making Calls
Turning DTMF Suffix-Dialing On and Off

While engaged in an external call, you can activate a sequence of digits to 
control answering machines or information and switching systems.

Select “Tone dialing” from the “Edit” menu or click the “Tone dialing” but-
ton.

or

A window for entering the DTMF digit sequence appears. Enter the digit 
sequence and click the “OK” button.

Making Internal Calls
Enter the number of the internal station and press Enter to confirm.

You can also dial the station from Outlook “Contacts” Æ Page 83, the busy 
lamp field Æ Page 41, or the repertory dial keys Æ Page 40.

Making Calls With Repertory Dial Keys
Use the repertory dial keys to call a station directly. If repertory dial keys 
have been configured in optiClient Attendant Æ Page 96, the Repdial keys 
option appears on the menu bar.

Select the Repdial keys option from the menu bar to open a pull-down 
menu with the repertory dial keys.

Select the name of the station that you want to call.
The station number is dialed.

You can program the system so that automatic line seizure is acti-
vated. It will then be unnecessary to dial the external code when 
placing external calls.
 However, you will then have to click the “Internal” button before 
placing internal calls. This button is displayed only if automatic line 
seizure is activated.

You can also store codes for controlling voice mail systems and an-
swering machines on repertory dial keys.
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Making Calls With the Busy Lamp Field
Click the busy lamp field button in the toolbar.  
The busy lamp field appears.

Idle State
You are not in the talk state and want to place a call.

With the left mouse button, click the status button for the station that you 
want to call.

The station number is automatically dialed.

Switching State
You are engaged in a call and want to forward the call to a station in the 
busy lamp field. There are three ways to do this:

Screened Transfer

With the left mouse button, click the status button for the station to which 
you want to transfer the call.

Wait until the destination station responds and announce the call.

Connect the station by clicking the Clear button.

Unscreened Transfer

With the left mouse button, click the status button for the station to which 
you want to transfer the call.

Wait for the ring tone.

Connect the station by clicking the Clear button.
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Making Calls
Speed Transfer

Right click the status button for the station to which you want to transfer 
the call. A popup menu with several functions opens.

Select the menu item “Speed transfer” from the popup menu. The call is 
immediately forwarded to the selected station. If this station is busy, the 
busy station is automatically camped on after approximately five seconds 
(can be configured by the relevant service personnel). If the station cannot 
be reached, the call is signaled in the call display as a recall after approxi-
mately forty seconds (can be configured by the relevant service person-
nel).

Making Calls With Redial
The last ten station numbers dialed are automatically stored. If the station 
you dialed is busy or unavailable, you can initiate a redial the next time you 
call instead of having to reenter the station number.

Click the redial button in the toolbar 
to open a pull-down menu with the last station numbers dialed.

Select the desired station number. The number is automatically dialed.

Double-clicking a status button has the same effect as single-click-
ing it.

By default, optiClient Attendant saves both internal and external 
station numbers. However, you can program optiClient Attendant 
to store only external station numbers in the redial list Æ Page 91.
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Making Calls with the Electronic Telephone Book
Prerequisite: the search in Outlook “Contacts” is deactivated Æ Page 100.

1.

In the “Name/Station number” entry field of the attendant monitor, enter 
the surname of the party you want to find in the traffic display and press 
“Enter” to confirm. If the name is saved in the Electronic Telephone 
BookÆ Page 77, it opens automatically displaying the matching name.

or

Open the Electronic Telephone Book and highlight an entry.

2.

or If you want to call a user on his/her cellphone, for example, instead of via 
the default number, you can select this number from the “Station number” 
selection list, provided it is entered in the ETD Æ Page 79.

3.

or
Click the “Dial” button or confirm with “Return”. 

The station number is dialed.

For a detailed description of this function see Æ Page 78.
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Making Calls
Making Calls From “Contacts” in Microsoft Outlook
Prerequisite: the search in Outlook “Contacts” is enabled Æ Page 100.

1.

In the “Name/Station number” entry field of the attendant monitor, enter 
the surname of the party you want to find and press “Enter” to confirm. If 
the name is stored in Microsoft Outlook, the Outlook search list window 
opens and the name(s) are listed.

2.

Using the left mouse button, double-click the line containing the required 
entry.

The station number is dialed.

For a detailed description of this function see Æ Page 83.
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Consultation/Transfer/Conference
Consultation/Transfer/Conference

Transferring Calls
The following methods can be used to transfer an answered call to an in-
ternal or external station. If you are unable to transfer calls to external sta-
tions, this is because you are not authorized to do so (consult your relevant 
service personnel).
• Screened transfer: The person you are talking to would like to consult 

another party. Call the desired party and announce the call.
• Unscreened transfer: The person you are talking to would like to con-

sult another party. Dial the number of the desired party, wait for the ring 
tone, and connect the two parties without announcing the call.

• Speed transfer: The person you are talking to would like to consult an-
other party. Dial the number of the desired party and connected the 
two parties without waiting for the ring tone.

• Transfer after parking/holding: The external party you are talking to 
would like to consult another party. You place the call on hold or park 
the call. Dial the number of the wanted internal or external party, an-
nounce the call and then connect the two parties.
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Consultation/Transfer/Conference
Screened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While engaged in the call, left-click the status button for the station to 
which you want to transfer the call. The system dials the number.

or

While engaged in the call, enter the number of the station you wish to 
reach and press Return to confirm. The system dials the number (you can 
also dial the party from Outlook “Contacts” Æ Page 83 or using repertory 
dial keys Æ Page 40.)

The two stations appear in the traffic display:
The first party is automatically placed on hold.

3.

O Wait until the destination station responds and announce the call.

4.

Connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic 
display and you are free to answer another call.

If the station is busy or does not answer, click the Back button to return to 
the first party.

Space Bar
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Consultation/Transfer/Conference
Unscreened Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While engaged in the call, left-click the status button for the station to 
which you want to transfer the call. The system dials the number.

or

While engaged in the call, enter the number of the station you wish to 
reach and press Return to confirm. The system dials the number (you can 
also dial the party from Outlook “Contacts” Æ Page 83 or using repertory 
dial keys Æ Page 40.)

Both stations appear in the traffic display.
The first party is automatically placed on hold.

3.

Wait for the ring tone and connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic 
display and you are free to answer another call.

If the third party is busy or does not answer, click the “Back” button to re-
turn to the first party. If the third party does not answer the transferred call 
within 40 seconds (time can be programmed by the relevant service per-
sonnel), the call appears as a recall in the call display.

Space Bar
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Consultation/Transfer/Conference
Speed Transfer

1.

Accept the call.
The call appears on the traffic display.

or

2.

While still conducting the call, right-click the status button for the station 
to which you want to transfer the call. The station number is dialed and the 
call is automatically forwarded to the station dialed.

If the party does not answer the transferred call within 40 seconds (time 
can be programmed by the relevant service personnel), the call appears as 
a recall in the call display.

Space Bar
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Consultation/Transfer/Conference
Transfer after parking/placing on hold
Prerequisite: You have placed an external call on hold Æ Page 51 or 
parked it Æ Page 54. The held/parked call is indicated in the call list.

1.

Click the left mouse button on the status button of the user whom you 
wish to call. The number is dialed.

or

During the call, enter the number of the internal or external party whom 
you wish to call, confirming your input with the “Return” button. The num-
ber is dialed. (You can also use Outlook “Contacts” Æ Page 83 or the rep-
ertory keys Æ Page 40 to dial this party.

2.

O Announce the call to the wanted party.

3.

Click the “Hold” button.

or

Press the “F4” button (this must be configured Æ Page 102).

4.

Double-click the left mouse button on the entry for the held/parked call in 
the traffic display.

Connect the station by clicking the Clear button.

As soon as the stations are connected, their data is deleted from the traffic 
display and you are free to answer another call.

F4
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Consultation/Transfer/Conference
Consultation Hold
You are conducting a call and want to obtain information from another in-
ternal or external party without the first party overhearing. If you are unable 
to transfer calls to external stations, this is because you are not authorized 
to do so (consult your relevant service personnel)

Prerequisite: You are making a call.

Enter the station number and press Enter to confirm your entry. The sta-
tion number is dialed.
(You can also dial the station from Outlook “Contacts” Æ Page 83, the 
busy lamp field Æ Page 41, or the repertory dial keys Æ Page 40.)

O When the station answers, you can conduct a consultation call. The first 
party is automatically placed on consultation hold, meaning that he or she 
cannot overhear your conversation.
When the other party hangs up, you automatically return to the party on 
hold.

Terminating Consultation Hold

Click the Back button to terminate the consultation and return to the wait-
ing party.
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Consultation/Transfer/Conference
Hold
You can place external calls on hold whenever you want, for example, to 
call another station.Æ Page 49

Placing External Calls on Hold
Prerequisite: You are currently conducting an external call.

Click the “Hold” button.

or

Press the “F4” button (this must be configured Æ Page 102).

If this is configured Æ Page 103, you can enter any text for the party to be 
placed on hold. You can still speak with the caller while entering the text.
Confirm the input.

The other party is placed on hold and cannot listen in. The held call is indi-
cated in the call list.

Click the Clear  button. You are now available to answer other calls.

You can also place more than one external call on hold.

Activating a Held Call

Prerequisite: You are not engaged in a call.

Using the left mouse button, double-click the line in the call list which con-
tains the held call you wish to take.
You are reconnected to the held party.

Internal calls cannot be placed on hold.
They can, however, be placed on consultation hold Æ Page 50 or 
parked Æ Page 54.

F4
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Consultation/Transfer/Conference
Toggle
The toggle function allows you to alternate between two calls. The station 
currently waiting cannot overhear your conversation. 

Prerequisite: You are currently conducting a call and another party is wait-
ing (for example, on consultation hold).

Click the Toggle button to change to the waiting party. 

or

Press the “F6” button (this must be configured Æ Page 102).

You change to the waiting party.

Interconnecting Two Parties
Click the Clear button to interconnect the two stations.

Set up conference
You can set up a three-party conference between yourself and the other 
two parties by clicking the “Set up conference” button Æ Page 53.

F6

You cannot activate the toggle function if you 
used the Hold button to place one of the two parties on hold.
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Consultation/Transfer/Conference
Conference
You can add another party to an existing call to form a three-party confer-
ence in which all three parties can speak to one another.

Prerequisite: You are currently conducting a call and another party is wait-
ing (for example, on consultation hold).

Click the “Initiating conference” symbol command button.

or

Press the “F10” button (this must be configured Æ Page 102).

The message Conference is displayed in the status box for both parties. 
The three-party conference is initiated.

The  icon appears in the status bar.

Terminate conference
 Left-click the icon in the status bar.

All conference members are then disconnected and the  icon disap-
pears from the status bar.

Click the Clear button to leave the conference; the other two parties re-
main interconnected.

F10

You can also initiate the conference after toggling (several times) 
Æ Page 52.
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Consultation/Transfer/Conference
Park
You can park a call that you have answered but have not forwarded. The 
parked call can be connected to another party Æ Page 49.
Your optiClient Attendant can be configured so that a waiting call automat-
ically places the current call on hold. For more information on this function, 
please get in touch with your relevant service personnel.

Prerequisite: You are engaged in a call.

Click the Park button to park the call. 

or

Press the “F7” button (this must be configured Æ Page 102).

If this is configured Æ Page 103, you can enter any text for the party to be 
parked. You can still speak with the caller while entering the text.
Confirm the input.

The parked call is shown on the call display. The optiClient Attendant auto-
matically parks the call in the next available park slot.

Each telephone system has park slots for ten calls, which both you and oth-
er internal parties can park.

Answering Parked Calls 
Prerequisite: You are not engaged in a call.

Using the left mouse button, double-click the line in the call list which con-
tains the parked call you wish to take.
You are reconnected to the held party.

The parked call disappears from the call display.

F7

If calls simply “disappear” from your parking list, they may have 
been answered by other internal parties.
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Consultation/Transfer/Conference
Overriding Calls

If an emergency arises and you must speak to a busy internal station, you 
can break into the busy station’s call and speak to the party. You will then 
hear an alerting tone.

In order to prevent parties from breaking into existing calls undetected, the 
message “Override: ...“  appears on the display of the telephone involved 
and the parties are reminded every two seconds by a dual tone that they 
are in an override situation.

1.

Dial the internal station number. You hear a busy signal. As soon as you 
heard the ring tone you are camping on at the other station.

2.

Click the override button in the toolbar. 
You can speak to both parties.

or

Press the “F8” button (this must be configured Æ Page 102).
You can speak to both parties.

Click the Clear button to leave the call. The other parties remain intercon-
nected.

Overriding Do Not Disturb

Prerequisite: You are authorized to override do not disturb (can be config-
ured by relevant service personnel).

You urgently need to reach an internal station that has activated do not dis-
turb.

Dial the internal station number. You hear a busy signal. 
After a brief wait, the system automatically overrides do not disturb. You 
hear a ring tone and the destination telephone starts ringing.

This function is not available network-wide Æ Page 90.

F8

This function is not available network-wide Æ Page 90.
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Consultation/Transfer/Conference
Station Number Display Suppression
You can prevent the attendant console’s station number or name 
(for example, Switchboard ) from appearing on the called party’s display 
(not for internal calls).
You must activate this display suppression before dialing; it then remains 
activated until you cancel it.

Activating Display Suppression

Select “Privacy on/off” from the “Edit” main menu or click the “Privacy on/
off” button.

or

The  icon appears in the status bar.

If you now call external party, neither the station number nor the name of 
the attendant console will appear on his or her display.

Deactivating Display Suppression

Select “Privacy on/off” 
from the “Edit” main menu. 

or

 Left-click the icon in the status bar.

The  icon disappears from the status bar.

The next time you place an external, your station number or name will ap-
pear on the called party’s display.
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Reaching Parties More Effectively
Reaching Parties More Effectively

Automatic Callback
When you cannot reach specific parties, you can send them callback re-
quests to save yourself from attempting additional calls.

1.

Enter the station number and press “Enter” to confirm your entry. The sta-
tion cannot be reached.

2.

Click “Activate callback” in the toolbar.
The  icon appears in the status bar.

Your callback request is sent to the called station.

The system automatically calls back when:
• The called party hangs up.
• The called party returns and has conducted a call.
• The called party displays his or her messages and responds to the call-

back request.

When you answer the callback, you first will hear a dial tone and then the 
other party will be called.

You can store up to ten callback requests.
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Reaching Parties More Effectively
Displaying and Canceling Callback Requests
You can display and cancel callback requests that you have already issued.

Click the “Menu Window” button.

or

 Left-click the icon in the status bar.

The menu window is displayed.

Using the ,  and  buttons, you can retrieve and cancel the 
callback requests.

The  icon disappears from the status bar.

Using the  button in the menu window, you can cancel the input and 
close the window.
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Reaching Parties More Effectively
Paging

You can issue a speaker announcement to specific groups through your 
telephone. These groups can be made up of telephones and speaker sys-
tems; they are configured and assigned group numbers by the relevant 
service personnel. These group numbers must be set to “active” mode in 
the optiClient AttendantÆ Page 95.

Select the Paging option from the menu bar to open a pull-down menu 
with the paging groups.

Select the group that you want to page. 
The group number is dialed automatically. You can now make your an-
nouncement.

This function is not available network-wide Æ Page 90.

The Paging menu option appears in the menu bar only if paging 
groups have been activated in the Settings window.
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Reaching Parties More Effectively
Speaker Call

You can record an announcement without any assistance via connected 
loudspeakers (ask relevant service personnel) or at an internal station with 
access to a system telephone.

Click the “Speaker call” button. 

The following dialog box is displayed:

Enter the number of the station to which you want to directly speak and 
click “OK” to confirm your entry.

The station is automatically dialed and you can then speak immediately 

This function is not available network-wide Æ Page 90.
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Reaching Parties More Effectively
Messages

Sending a Message
You can send info texts to individuals or station number groups with sys-
tem telephones. Info texts sent to system telephones without a display 
(for example, optiPoint 500 entry), ISDN, impulse or tone dial telephones 
are saved as callback requests.

Click the message button in the toolbar.

The following dialog box is displayed:

Enter the number of the internal station or group to which you want to 
send a message and click “OK” to confirm your entry.

The menu window appears.

Messages can also be sent to stations in networked systems.
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Reaching Parties More Effectively
Using the ,  and  buttons, you can select from among ten 
predefined, brief messages, or enter a separate text:

0 = Please callback
1 = Someone is waiting
2 = Appointment
3 = Urgent call
4 = Do not disturb
5 = Fax waiting
6 = Dictation please
7 = Please come see me
8 = Please make copies
9 = Ready to depart
Enter other text

The number and content of the brief messages listed here may differ from 
the messages actually stored in your system.

If you selected “Enter other text” you can enter any text. Click the  
button to open the text input window and enter a text.

As soon as you confirm the option “Send“ in the menu, the message is 
sent.

Using the  button in the menu window, you can cancel the input and 
close the window.
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Reaching Parties More Effectively
Display/Delete Sent Info

Click the “Menu Window” button.

The menu window is displayed.
Scroll down using the  button to “Sent message” and confirm with 

.

The ,  and  buttons enable you to view the sent messages 
and the time at which they were sent, and delete these messages.

The  button in the menu window enables you to cancel the display and 
close the window.
63



Reaching Parties More Effectively
Receiving a Message
If messages are waiting for you, these appear in the menu window.
These are signaled by the “message“  icon in the status bar.

Click the “Menu Window” button.

or

 Left-click the icon in the status bar.

The menu window is displayed.

Using the ,  and  buttons, you can view the messages re-
ceived
, call the sender and delete the message.If there are no further messages 
in the list after deletion, the  icon disappears from the status bar.

Using the  button in the menu window, you can cancel the input and 
close the window.

Texts sent to groups can only be deleted by the sender.
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Reaching Parties More Effectively
Transferring an External Trunk

You can transfer an external trunk to an internal user who is not authorized 
to set up outgoing external calls, thus enabling this party to set up an ex-
ternal call independently.

Prerequisite: You are talking to a party who does not have direct trunk ac-
cess.

Click the Transfer trunk button.

Click the Clear  button. You are now available to answer other calls.

This function is not available network-wide Æ Page 90.

Parties without direct trunk access must enter the external code be-
fore dialing an external number.
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Reaching Parties More Effectively
Releasing an External Trunk

You want to place an urgent external call and receive a busy signal because 
no external trunk is available. You can select a busy trunk and disconnect 
the call on this trunk to make the trunk available for your call. 

Keep in mind that this function disconnects calls in progress and should be 
used only in dire emergencies.

Releasing a Busy Trunk

You wish to dial an external station number but already hear a busy signal 
before you dial.

Click the release trunk icon in the toolbar.

The menu window appears.

Using the ,  and  buttons, you can select and release an 
external trunk.

Using the  button in the menu window, you can cancel the input and 
close the window.

Now enter the station number and press Enter to confirm your entry. The 
station is dialed via the released trunk.

This function is not available network-wide Æ Page 90.

If your system is not configured for releasing an external trunk, the 
release trunk button will not appear in the toolbar.
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Reaching Parties More Effectively
Radio Paging (PSE) (Not for U.S.)

If you call an internal station and cannot reach the party at his or her work-
station, you can call the absent party using the radio paging equipment.

Prerequisite: radio paging must be programmed in the system.

Select the “PSE” menu item from the “Edit” main menu.

The following dialog box is displayed:

Enter the desired party’s station number (for example, his or her pager 
number) and press Enter to confirm your entry.

The menu window appears.

Using the ,  and  buttons, you can enter a message 
(for example, a station number) for the party and page this party.

Using the  button in the menu window, you can cancel the input and 
close the window.

If the party paged does not respond or if the radio paging equipment shuts 
off after a certain period of time, you can cancel the page by clicking the 
Clear button.

This function is not available network-wide Æ Page 90.
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Forwarding Calls
Forwarding Calls
You can forward both internal and external calls to various destinations (in-
ternal or external telephones) (whether external destination is possible de-
pends on system configuration).

Activating Call Forwarding

Click “Activate call forwarding“ in the toolbar. 

The following dialog box is displayed:

Enter the station number of the call forwarding destination (internal or ex-
ternal telephone) and click OK to confirm your entry.

Call forwarding is activated and the  icon appears in the status bar.

Deactivating Call Forwarding

 Left-click the icon in the status bar.

Call forwarding is deactivated and the  icon disappears from the status 
bar.
68



Night Answer
Night Answer

Night answer is activated when your attendant console is unattended 
(for example, after office hours). External calls are forwarded to any internal 
night destination (such as the security officer) that you select. The service 
personnel can configure whether or not the optiClient Attendant will be au-
thorized to activate night answer.

You can enter and select from among up to eight different internal night 
destinations.

Entering a Night Destination
From the File menu, select the Settings option to open the Settings win-
dow.

Select the Night destinations tab.

Enter the possible internal night destinations in the text boxes.

Click OK to confirm your entries.

Click the Back button to return to the attendant monitor.

To select a night destination, click “Change night dest.” in the Edit menu 
Æ Page 70 and click the Night service button to activate itÆ Page 71.

This function is not available network-wide Æ Page 90.
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Night Answer
Selecting a Night Destination
You can select which night destination (from among up to eight internal 
night destinations) will answer incoming calls. To do this, either select a 
predefined night destination Æ Page 69 or enter one manually.

Predefined night destination

Select “Change night dest.” from the “Edit” menu. The following pull-
down menu appears:

Select a night destination. The night destination selected is identified by a 
check mark. 

After you activate the night service Æ Page 71, all calls are forwarded to 
this night destination.

Entering a night destination manually

Select “Change night dest.” from the “Edit” menu. The following pull-
down menu appears:

Select the “Manual input” option.

The following dialog box is displayed:

Enter the night destination number and click OK to confirm. 
To select the night service programmed in the system by the service per-
sonnel, enter an asterisk (*) for the night destination.
After you activate the night service Æ Page 71, all calls are forwarded to 
this night destination.
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Night Answer
Activating Night Answer
Click the “Activate night answer” icon in the toolbar. 

Call forwarding to the night destination is activated and the  icon ap-
pears in the status bar.

Deactivating Night Answer
 Left-click the icon in the status bar.

Call forwarding to the night destination is deactivated and the  icon dis-
appears from the status bar.

You must still answer any waiting calls in the call display. Any new 
calls are forwarded to the night destination.
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Notebook
Notebook
The Notebook function opens the “Editor” program in Windows.

Opening the Notebook

From the Window menu, select the Notebook option.

The Editor is displayed.

You can save, open and print the notebook files via “File” in the Editor 
menu. 
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Call Detail Recording for Individual Calls
Call Detail Recording for Individual Calls

When a party using an internal telephone (one that is accessible to the 
public, such as a pay phone) terminates a chargeable call, the call charges 
can be displayed on the optiClient Attendant console.
However, the service personnel must have configured the “pay phone” 
function in the system.

Click the “Call box” button.

The menu window appears.

Using the ,  and  buttons, you can select the internal sta-
tion and display, print or delete the call charges incurred and the call dura-
tion.

Using the  button in the menu window, you can cancel the input and 
close the window.

This function is not available network-wide Æ Page 90.
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Programming/Changing Repdial Keys
Programming/Changing Repdial Keys
You can program the station numbers or codes you use the most on the 
ten repertory dial keys. A sequence of codes can be used to control a voice 
mail system or an answering machine or activate functions on the commu-
nications platform (such as entering “#82” to display the caller list).

From the File menu, select the Settings option to open the Settings win-
dow.

Select the Repdial keys tab.

In the text boxes, enter the names and station numbers of the stations de-
sired.

Click OK to confirm your entries.

Click the Back button to return to the attendant monitor.

You can now reach your parties directly via the repdial keys.

From the menu bar, activate the Repdial keys menu Æ Page 40 to access 
the pull-down menu with the repdial keys.

The Repdial keys option appears in the menu bar only if you have 
configured repertory dial keys in the Settings window Æ Page 96.
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Use Caller List
Use Caller List
The caller list displays all incoming calls (answered and unanswered) in a 
chronologically sorted list. You can use this list to conveniently return calls 
and delete entries from the list.

Click the “Caller list” button. It opens the “Caller list” window.

The list is sorted in chronological ascending order, for example, the most 
recent calls are located at the end of the list. If the entries do not fit in the 
list window, a scroll bar appears to view the complete list.

Click on the “Close” button to close the window.

Return Calls
Using the left mouse button, double-click the line containing the required 
entry.
The station number is dialed.

The list window can only be displayed if entries are found in the list.

Date of call

Scroll bar

Caller station number

Time of call
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Use Caller List
Delete Individual Entries
Highlight some list entries by clicking and dragging.

or

Add individual entries to those highlighted or delete individual entries from 
your selection.

Click “Delete Selected Entries” in the list window.
The selected entries are deleted without requesting confirmation.

Delete Entire List
Click “Delete List” in the list window.
The entire list is deleted without requesting confirmation and the list win-
dow is closed. 

Ctrl +
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Electronic Directory (ETD)
Electronic Directory (ETD)
The electronic directory provides you with a convenient means of search-
ing for stations and dialing the numbers. You can also display detailed in-
formation on the stations. 
In the default configuration, a database for the ETD is loaded when the 
optiClient Attendant is started up.

Starting the ETD
To start the ETD, select the Directory option from the Window menu.

or

Click the directory button in the toolbar.

The main window of the directory is now displayed containing all the sta-
tions in the directory with their data.

Record

Edit 
 Record

Data fields

Generate new 
record

Provide station num-
ber for dialing

Return to 
Attendant 
Monitor
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Electronic Directory (ETD)
Searching for a Station
You wish to call Mr. Adams. However, you do not know Mr. Adam’s station 
number.

Prerequisite: the search in Outlook “Contacts” is deactivated Æ Page 100.

Enter the first few letters of the name of the party you want to find in the 
“Name/Station number” entry field of the attendant monitor (for instance, 
“Ada”) and press “Enter” to confirm. If the electronic directory contains 
the combination of initial letters entered, it automatically opens the tele-
phone book with the matching entries.

The first station name in the ETD that matches the initial letters entered is 
highlighted. Select the desired station.

Click the Dial button.

The station number is transferred to the attendant monitor.

Click the General button to dial the station number.

or

Press Enter to dial the stored station number.

When you search the ETD for a station, the first 100 records located 
are displayed. If you do not see the station you are looking for, enter 
a more specific search word.
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Electronic Directory (ETD)
Adding New Stations
In the directory’s main window, click the New entry button to open another 
window that has two different tabs on which you can enter a new station 
in the ETD.

The window contains the two tabs “General” and “Additional”. On these 
tabs you can enter additional data for the station.

General
On the “General” tab you can enter the user’s name, company, address 
and various telephone numbers.
When calls are made by way of the telephone directory Æ Page 44, the 
number is displayed in the “Station number” field (default setting) and 
then dialed. The four other possible numbers can then also be selected.

Save record
Return to main di-
rectory window

General tab Addition-
al tab
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Electronic Directory (ETD)
Additional
You can use the “Additional” tab in order to enter further data, for example 
the user’s department or corporate rank or several lines of notes, e.g. de-
tails of the company’s business hours.

Click the save icon to save the data.

Click the “Close” button to return to the main directory window 
Æ Page 77. The new station and its data are displayed here.

Click the “Close” button in the main directory window to exit the ETD and 
return to the attendant monitor.

If you click the “Close” button without saving the record, the record 
is automatically saved and you are returned to the directory’s main 
window.
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Electronic Directory (ETD)
Editing an Entry
Click the Edit button in the directory’s main window to open another win-
dow with two different tabs on which you can modify the information for 
the selected party.

From the directory’s main window, select the party whose entry you would 
like to modify.

Click the “Edit” button.
Another window is displayed with two different tabs on which you can 
modify the party’s data.

Click the save icon to save the data.

Click the “Close” button to return to the main directory window 
Æ Page 77. The new station and its data are displayed here.

Click the “Close” button in the main directory window to exit the ETD and 
return to the attendant monitor.

Return to main di-
rectory window

Save record

If you click the “Close” button without saving the record, the record 
is automatically saved and you are returned to the main directory 
window.
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Electronic Directory (ETD)
Delete Entry
Click the “Edit” button in the main directory window to open another win-
dow with which you can delete the entry.

From the main directory window, select the party whose entry you would 
like to delete.

Click the “Edit” button. 

Delete the entry with “Delete”.

Confirm your request with “Yes”.

Click the “Close” button in the main directory window to exit the ETD and 
return to the attendant monitor.

Delete 
record
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Telephone Book Function with Outlook “Contacts”
Telephone Book Function with 
Outlook “Contacts”
The telephone book function provides you with a convenient means of 
searching for stations and dialing the numbers. The Microsoft Outlook 
“Contacts” folder is used as a data source for this.

Searching for a Station
You wish to call Mr. Adams. However, you do not know Mr. Adam’s station 
number.

Prerequisite: the search in Outlook “Contacts” is enabled Æ Page 100.

Enter the first few letters of the name of the party you want to find in the 
traffic display in the “Name / Station number” entry field of the attendant 
monitor (for instance, Ada) and press Enter to confirm. If “Contacts” in Mi-
crosoft Outlook contains the combination of initial letters entered, the 
“Outlook search” list window displaying the search results is automatically 
opened.

The first station name that matches the initial letters entered is highlighted. 
Select the desired station.

Using the left mouse button, double-click the selected line.

Please note:
• Microsoft Outlook Express is not supported.
• Canonical format is supported.
• Special features must be taken into consideration regarding the 

format of the contact name in Microsoft Outlook Æ Page 108.
• Only the entries in the Outlook “Contacts” folder are used when 

running searches in Microsoft Outlook. Sub-directories are not 
searched.
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Telephone Book Function with Outlook “Contacts”
or

Press Enter.

or

Right-click the selected line if you wish to call a user on his/her cellular 
phone, for example, instead of via the default number.

If several numbers were entered in the ETB for the same user, a pop-up 
menu appears. Select the required number from the menu.

The station number is dialed.

When you search for a station, the first 100 records located are dis-
played. If you do not see the station you are looking for, enter a 
more specific search word.
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Telephone Book Function with Outlook “Contacts”
Searching on the Basis of Other Station Data
You can also base a search on other data such as a company name, city or 
postal code. The example below uses a company name. A search by city 
or postal code is conducted in a similar manner.

Click the “Outlook” button. The following popup menu appears:

Select the desired property from the menu which will be used in the 
search, for example, “Company”.

The following dialog box is displayed:

Enter the company desired and click OK to confirm your entry.

If the company is stored in “Contacts” in Microsoft Outlook, the “Outlook 
search” list window opens with a list of the parties employed by this com-
pany. The first party is highlighted.

Updating Telephone Book Data
To enter new data or modify existing station data in the Microsoft Outlook 
“Contacts” folder, please refer to the Microsoft Outlook documentation.
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Search the Telephone Book
Search the Telephone Book
This function searches for names and phone numbers in the telephone 
book.

1.

Click the “Telephone Book” button. 

or

Select the “Search the telephone book” menu item from the “Window” 
menu.

or

Press the “F12” key.

The “Search the telephone book” window opens.

2.

Enter a name. You can also enter part of a name, for example “mil” for 
“Miller”. The search function is not case-sensitive. Confirm with “OK”. 

3. If one or more entries are found, these are displayed in the menu window. 

Using the ,  and  buttons, you can select and call a station.

Using the  button in the menu window, you can cancel the input and 
close the window.

This function must be supported by your communications platform. 
Please ask your service personnel to activate this function.

F12
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Starting telephone directory CD
Starting telephone directory CD
A telephone directory CD can be started by way of the “telephone direc-
tory CD” button in the main window of the optiClient Attendant.
The precondition is that the telephone directory CD has been integrated 
into optiClient Attendant.
Integration of the telephone directory CD function, see Æ Page 100.

Operation of the telephone directory CD varies according to the telephone 
directory CD software which is used.
In order to use the telephone directory CD, please read the documentation 
supplied with the telephone directory CD software.

Using a number on the telephone directory CD
The number located on the telephone directory CD is transferred by copy-
ing it and then entering it in the traffic display of the optiClient Attendant.

Use the mouse to mark the wanted number in the telephone directory CD 
program.

Press “Ctrl” and “C” to place the data in temporary storage.

Position the cursor in the “Name/Station Number” field in the switching ar-
ea.

Press “Ctrl” and “V” to copy the data from temporary storage to the traffic 
display.

Ctrl C+

Ctrl V+
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Opening search window for LDAP server
Opening search window for LDAP server
The search function within the LDAP server is activated with the “Search 
window for LDAP server” button in the main window of the 
optiClient Attendant.

The precondition is that this search function has been integrated in the 
optiClient Attendant. To activate this search function, see Æ Page 100.

Please note:
• Canonical format is supported.
• Names are only searched for in the “Surname” field in Microsoft 

Active Directory Server.

This search function uses functions of your PC operating system 
which are only available after an update under Windows®98 and 
Windows®NT.
Please get in touch with your system administrator to update your 
operating system.
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Emergency Operation
Emergency Operation
When you exit the optiClient Attendant or in the event of an application fail-
ure, the optiClient Attendant changes over to emergency operation. All the 
features of your telephone system are retained and you can continue to ex-
ecute all switching functions from your optiPoint or optiset E system tele-
phone (not in conjunction with optiClient 130).

To return to your PC attendant console, restart the optiClient Attendant 
program Æ Page 13.
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Special Functions in the LAN (PC Network)
Special Functions in the LAN (PC Network)
If your optiClient Attendant is operating in an IP network from 
HiPath AllServe 3000/5000 RSM systems, multiple communications plat-
forms are interconnected via a LAN (Local Area Network, e.g. proprietary 
PC network). Your telephone calls are conducted via the LAN.

Busy Lamp Field

It is not possible to set station names and numbers network-wide. Station 
names and numbers outside the local number plan must be entered man-
ually Æ Page 25.

Additional Special Features

The following functions are not available network-wide:
• Door Opener Æ Page 36
• Overriding Calls Æ Page 55
• Overriding Do Not Disturb Æ Page 55
• Paging Æ Page 59
• Speaker Call Æ Page 60
• Transferring an External Trunk Æ Page 65
• Releasing an External Trunk Æ Page 66
• Radio Paging (PSE) (Not for U.S.) Æ Page 67
• Night Answer Æ Page 69
• Call Box Æ Page 73

Configuring the optiClient Attendant
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Entering Settings
Entering Settings
The settings that can be activated in the optiClient Attendant “Settings” 
window are described in this section. 
For further settings see Æ Page 99.

System
In the “System” directory, you can specify the connection type, activate 
the settings for the busy lamp fields (BLF) and activate general settings for 
the attendant console.

Connect to: 

Select the PC interface for the following connection types in the selection 
list field:
• optiset control/data adapter: “COM 2" or “COM 1"
• USB: “COM 3"
• optiClient 130: “IP”

System Update  

Data relevant to optiClient Attendant, such as the local call plan for exam-
ple, are transferred from the system to the PC via the “System Update” 
key.

Whenever a change is detected in the system configuration after 
start of the optiClient Attendant or during its operation, the 
optiClient Attendant is automatically updated. This procedure is in-
dicated in the status bar by the message “Please wait”.
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Entering Settings
Set BLF  

The “Set BLF” key allows you to transfer user data from the local call plan 
(your system’s users) to a busy lamp field.

Prerequisite: A call plan was loaded using “System Update” Æ Page 91 
and at least one BLF is displayed Æ Page 24.

Click the “Set BLF” key. 
A list window displaying the current user data opens automatically.

Highlight some or all of the list entries by clicking and dragging.

or

Add individual entries to those highlighted or delete individual entries from 
your selection.

Click a highlighted list entry, holding down the mouse button, drag the en-
try to the specific BLF status key after which you want to transfer the se-
lected entries (a “+” icon appears at the mouse cursor). 

Stations from networked systems can only be entered manually 
Æ Page 25.

To move status buttons on the BLF see Æ Page 26.

Ctrl +

Highlighted entries

BLF

List window
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Entering Settings
The highlighted entries are transferred to the BLF once you release the 
mouse button.

Number redial only for external numbers

This option allows you to restrict the number redial list to external calls.

Deactivate night answer at start

If you select this option, night answer is automatically deactivated (if it was 
previously activated) when the optiClient Attendant is started.

Activate silent call at start

If you select this option, the ring tone is automatically deactivated when 
starting optiClient Attendant (only in the case of connection via USB or a 
control/data adapter).

Call Detail File

This option (cannot be changed in optiClient Attendant) displays whether all 
chargeable calls with their values are to be saved in a call detail file.
Contact your service personnel to set up this function. The call detail file is 
stored in the installation directory of optiClient Attendant.

Transferred 
entries
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Entering Settings
Calls
In the other text boxes under this tab, specify the paths to the wave files 
(included in the software package) for ringer signaling on the PC. You can 
also assign individual Wave files with the “...” key and play them back with 
the speaker key. This must be activated for call signaling via wave files 
Æ Page 103.
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Entering Settings
Paging
Under the Paging tab, you can configure the existing groups in the commu-
nication system as active announcement groups. 

From the Existing groups box, select the groups that you want to be able 
to reach with a speaker announcement and transfer them to the Active an-
nouncement groups box.

“Paging” is now displayed as a menu option in the optiClient Attendant 
menu bar. This menu option allows you to issue speaker announcements 
to the configured groups.
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Entering Settings
Repdial Keys
Use the “Repdial keys” tab to program the ten station numbers or codes 
you use the most on repertory dial keys. A sequence of codes can be used 
to control a voice mail system or an answering machine or activate func-
tions on the communication server (such as entering “#82” to display the 
caller list).

In the input fields, enter either the name and station number of the station 
your wish to reach or the name and code for controlling a voice mail system 
or answering machine.  

The Repdial keys menu option is now displayed in the optiClient Attendant 
menu bar. This option provides you with a pull-down menu from which you 
can call the configured stations and access the configured functions direct-
ly.
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Entering Settings
Night Destinations
In the “Night destinations” tab you can enter up to 8 different internal night 
destinations. 
From the “Edit” menu with the “Change night dest.” menu item, you can 
select a night destination and activate it via the “Night answer” button.
 All calls are forwarded to this destination.
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Entering Settings
Saving Settings
Once you have entered your settings in the Settings window, you must 
save your entries in order for the changes to be applied.

In the Settings window, click OK to confirm your entries.

When you return to the attendant monitor, the message Please wait may 
appear in the status bar of the attendant monitor while 
optiClient Attendant is being updated with the new settings. As soon as 
the update operation has been completed, the message System ready is 
displayed. The optiClient Attendant is ready for operation.

Click the Back button to return to the attendant monitor without save 
the changes.
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Configuration Manager
Configuration Manager
This program can be used to activate additional settings not available under 
“File” - “Settings” for optiClient Attendant.

Starting Configuration Manager
Click the “Configuration Manager” button in the toolbar. 
The Configuration Manager is opened.

optiClient Attendant must be restarted in order for the changes to 
some functions to be applied. 

To apply changes to BLFs Æ Page 101, you must simply activate 
them via the  key.

Menu bar

Transfer button Configuration area

Menu tree
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Configuration Manager
Entering Settings

Telephone Book

To run a search in a Telephone book CD Æ Page 87, enter the complete 
path to a telephone book program under “CDROM Telephone Book” or se-
lect an executable file via “...”.

To run a search on the LDAP server Æ Page 88, enter a valid IP address or 
specify the name of the LDAP server under “LDAP Server”.

Activate “Use MS Outlook as telephone directory” in order to use the 
“Contacts” folder from the Microsoft Outlook program as a data source 
when searching in the “Name/Call number” entry field of the attendant 
monitor Æ Page 83. 
If this box is not checked, the ETD is used instead as a database for the 
search Æ Page 78.

Experience in configuring IP networks is required for certain set-
tings. Please contact your relevant service personnel for further in-
formation.
Incorrect configuration can result in the failure of important 
optiClient Attendant functions.
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Configuration Manager
Busy Lamp Field

Double-click the “Busy Lamp Field” entry with the left mouse button to 
show/hide its submenus.

Colours of BLF

You can determine the colours to be used for signaling the various line sta-
tuses of the status keys on the BLF here Æ Page 23.

Click the key beside the status whose colour you wish to change. A colour 
selection dialog appears.
You can select one of the predefined colours by clicking it or alternatively 
you can mix your own colour.
Click “OK” to confirm.

The availability of the “Station is diverted” and “Do not Disturb is ac-
tive” functions depends on your version of the communications plat-
form.
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Configuration Manager
BLF Configuration

The following settings can be performed for each of the three available 
BLFs Æ Page 23.

Enter the text that should appear in the title bar of the relevant BLF in the 
“Text for the BLF” field.

Specify how many status keys the BLF contains in the selection list field. 
You can select 20 to 240 status keys (number specified in multiples of 20).
Up to 140 keys can be selected in Name mode.

Activate “Display name” if you want the name to appear directly on the 
status key (Name mode). The names must be available for this.

If you activate “Display BLF” the relevant BLF is visible and is automatical-
ly displayed when starting optiClient Attendant. Configuration and key as-
signment are not deleted if the BLF is deactivated.

Function Keys
You can select the assignment of function keys on your PC keyboard.

Select a function key from “F1” to “F10”. 
For standard key assignment see Æ Page 114.
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Configuration Manager
Incoming and Outgoing Calls

• “Do not change focus on incoming call”
Here you can specify if optiClient Attendant is automatically displayed 
on top if multiple Windows programs are open.

• “Text input in Hold and Park”
Here you can specify if a window for entering text should be displayed 
when placing a station on hold Æ Page 51 or when parking Æ Page 54 
a station.

• “Wave file activated”
Here you can specify if the configured wave files Æ Page 94 should be 
audible for call signaling.

• “Deactivate automatic hold with end key”
Activate this function if simplified hold (hold without end key) is config-
ured in your communications platform.

• “Show the caller destination number”
Activate this function so that in the case of incoming calls which are not 
for you, the number of the station which the caller wanted to reach is 
entered in the field “call number/name” (the call number can then be 
directly dialed with “Enter”).

If automatic line seizure is not activated for the communications platform 
(contact System Support):
• you can specify which codes can be prefixed for external calls (e.g. “0”) 

in the “Extend trunk” field.
• you can activate automatic external code prefixing for trunk seizure 

from the specified number of digits by entering a station number 
length.
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Configuration Manager
Connection via IP
The following information is required for connection via IP (with 
optiClient 130).

Enter a valid IP address for the HG 1500 gateway in “IP Address HG 1500" 
(if available).

Enter the station number and password for reaching the 
optiClient Attendant via IP in the relevant fields.

Under “Mixer device used”, select the sound mixer to be used for audio sig-
nals on the PC.

Under “Recording device used”, you can select the device installed on the 
PC which is to be used for audio recording on the PC.

Under “Output device used”, you can select the device installed on the PC 
which is to be used for audio playback on the PC.

Activate the function “Use the USB phone headset” if you want to con-
duct conversations via the USB phone headset.

Tick “USB phone” if your USB phone is a Siemens product.

Connection for Braille Console
The following information is required for connecting a braille console.

From the selection list field, select the interface for the braille console 
(“Com 1" to "Com 4") and check the “Active” checkbox if the console 
should be activated via the selected interface.
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Configuration Manager
Statistics
The statistics function contains information on all incoming calls.

If the entries do not fit in the list window, a scroll bar is displayed to view 
the entire list.

Change display

Change column width:

To change the column width, click on the edge of a column (mouse pointer 
changes to a double-headed arrow) and drag the edge to the left or right 
by pressing and holding down the mouse key.

Change sort sequence:

Left-click the top of the column whose sort sequence (ascending or de-
scending) you want to change.

Reset statistics 

You can delete the statistics list. The empty list will then be filled up again 
with subsequent incoming calls.

Click the “Reset” button. The contents of the list are deleted without re-
questing confirmation.

Type of call (see Call Types Æ Page 19)
Caller station number

Name of the caller
Destination station number

Date of call
Time of call

Reset button
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Configuration Manager
Saving Settings
You must save your entries in order for the changes in Configuration Man-
ager to be applied.

Click “Transfer” to confirm changes.
Click “OK” to confirm the message in the dialog box.

Error Correction in optiClient Attendant

The “Transfer” button is only active if at least one modification was 
made in the Configuration Manager.
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Error Correction in optiClient Attendant
Error Correction in optiClient Attendant
This section discusses possible solutions to problems that may arise when 
operating optiClient Attendant.

The optiClient Attendant does not start correctly
• Check whether you have too many other programs open.
• Shut down your computer and switch it off and on.
• If the problem persists, uninstall the optiClient Attendant software and 

then reinstall it (see the - CD-ROM CDoptiClient Attendant booklet).

The optiClient Attendant is no longer responding
• Close any 16-bit applications that are open (such as Word 6.0).
• Check whether the HiPath system is still operating by verifying another 

telephone’s operation (the system may have failed).
• Shut down your computer and switch it off and on.

“Please wait” 
is permanently displayed on the status bar
• For optiset E telephones: 

Check the cable to ensure that the connection between the system 
telephone’s optiset E data/control adapter and the PC has been estab-
lished.

• For optiPoint telephones: 
Check the USB cable to ensure that connection between the system 
telephone’s USB port and the PC has been established.

Once the system is correctly connected, the message disappears and the 
optiClient Attendant is again ready for operation.

The busy lamp field is malfunctioning
• If the status button for a station is always red (indicating that the sta-

tion is busy), it may not mean that the station is constantly conducting 
calls but, instead, that the station telephone is defective or was re-
moved from the communication system. If such is the case, update 
the busy lamp field Æ Page 91 and Æ Page 92.

• If the status button for a station is always yellow (indicating that the 
station is being called) and you cannot pick up the call, it may mean that 
you are conducting a call or that you have a call waiting. In such cases, 
you cannot pick up the call.
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Error Correction in optiClient Attendant
Troubleshooting Using the Trace Button (Service 
Personnel Only)

The trace button allows you to store special error codes for reproducible 
errors in a text file that can then be passed on to a service technician at 
Siemens AG (intended for relevant service personnel only).

Configuring the Trace Button
• In the optiClient Attendant root directory, open the config.cfg file using 

any text editor. 
• Insert the following line under <System>: Trace=1
• Save the file and restart the optiClient Attendant. The Trace button 

now appears in the toolbar. 

Click the “Trace” button in the toolbar to open the error code window. De-
lete any old error codes using the “Clear” button. Generate the reproduc-
ible error and save the file. The file is saved as trace.txt in the 
optiClient Attendant root directory. Make a backup copy and send the file 
to the service technician for error analysis.

Existing Outlook Contacts are not displayed as a
search result

Searches for a name in Outlook “Contacts”, optiClient Attendant are only 
performed in the “Surname” field.

It is therefore necessary to enter the sequence “Surname  First 
name“when adding a contact, as otherwise the default settings in the Out-
look contact options will save an entry such as “Hofmann” as a “First 
name”.

Solution

Change the default contact options settings in Outlook.

To do this, open “Extras” - “Options” - “Settings” - “Contact options” in 
the Outlook menu and change the name sequence to “Surname  First 
name”.

Only the entries in the Outlook “Contacts” folder are used when 
running searches in Microsoft Outlook. Sub-directories are not 
searched.
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Important Keyboard Commands

"

Important Keyboard Commands
You can initiate the most important functions of the optiClient Attendant 
using the keyboard.

Keyboard

Answer calls.

Dial station number in General trunk group.

Place calls on hold.

Toggle between two calls.

Park calls.

Disconnect calls.

Dial station number in Private trunk group.

Return to waiting call.

Clear text boxes.

Dial station number.

Space Bar

Alt A+

Alt H+

Alt M+

Alt P+

Alt S+

Alt V+

Alt Z+

Del.
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Important Keyboard Commands
Function Keys

The function keys on your PC keyboard can have the following functions 
(default assignment), depending on the configuration of your 
optiClient Attendant Æ Page 102:

Call Help.

Find by name.

Terminate call (Clear).

Calls on hold.

Return to the waiting party.

Toggle between two calls.

Park the call.

Override a call.

Activate/deactivate microphone (mute).

Initiate conference.

Search the telephone book.

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10

F12
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